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1 Introduction 
Simplicity is a web system originally designed for the production and 
maintenance of popular scientific web sites that contain large quantities of 
data (images, videos, posters, wallpapers and the like) and metadata (image 
captions, descriptions, sizes, priorities etc.). However the system may have a 
much broader use.  
 
The necessary information for its implementation can be found at: 
 
http://www.spacetelescope.org/projects/web 
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2 Basic Definitions 

2.1 System overview 

The Simplicity system is put together by different simple components that 
briefly will be outlined here. A central theme in the system is to keep as much 
as possible in static files and only regenerate the files when necessary. 
 
Design 
Macromedia Dreamweaver manages the overall design with use of its template 
functionality, meaning that e.g. all normal static pages can easily be edited 
with use of the visual editor in Dreamweaver. However, other template systems 
are also used to generate e.g. dynamic content, but templates for these 
systems can just be seen as normal static pages for in Dreamweaver. Thus all 
HTML is managed eventually managed by Dreamweaver. 
 
Archives 
The central component in the system is the archives. An archive can be used to 
easily publish everything from press releases to kids drawings, and basically 
consists of index pages where you can browse the entries, and an entry page 
for each entry describing the entry and links to possible file downloads for the 
entry. 
 
Webshop 
The HubbleShop, a webshop solution for use with Commerz Bank (DE), is 
integrated into the archives so that products listed in the archives (e.g. 
posters, newsletters) can be sold or ordered for free. 
 
Search Engine 
To make the whole website searchable the website is indexed a couple of times 
during a week with the search engine ht:Dig. 
 
Link Checker 
Furthermore to prevent broken links etc. a link checker called Webcheck is 
running once a month a check all links. 
 
Statistics 
Evaluating the impact of e.g. a press release is very important in science 
communication, and thus we maintain normal web statistics but also more 
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specialized statistics to watch the number of downloads of e.g. a certain 
program. 

2.2 Web page design and structure 

The screen-shot below depicts a sub page of the web site. For the reading of 
this document it is important to note the names of the specific parts of a page. 
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3 Prerequisites/Reading guide 
Some preliminary advice and information: 

- A basic working knowledge of Macromedia Dreamweaver, 
Microsoft Excel and UNIX is desirable to make the fullest use of 
this documentation.  

- If possible, look at the files themselves while reading. 
- Names of files, parameters etc. are typed in Bold, pieces of code 

with Courier New and commands, file paths with Italics. 
 
The web site Spacetelescope.org has been used as an example for the 
implementation of the Simplicity web system throughout. Although most of the 
information here can be applied to any web site using Simplicity, there are 
some issues that are specific to Spacetelescope.org , such as the specific 
sitemap for Spacetelescope.org, the specific archives/data used in this site, the 
specific display types and the specific Perl scripts used. These serve only as 
specific examples of the consequences of decisions taken during the 
implementation process. 
 
The documentation is structured by the different components listed in section 
2.1, and further also into user guides (suitable for content maintainers) and 
technical documentation (suitable for developers). 
 
The spacetelescope.org web site has the following sitemap structure: 
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Home 
 • Copyright Information  
 
News 
 • List by year  
  2004 
  2003 
  2002 
  2001 
  2000 
  1999 
 
About Hubble 
  Fact Sheet 
  Spacecraft 
  Instruments  
   ACS 
   WFPC2 
   STIS 
   NICMOS 
   FGS 
   (COSTAR) 
   FOC 
   WFPC1 
   FOS 
   HSP 
  Orbit 
  Operations 
  Institutions 
  Solar Panels  
  Old Solar Panels 
  Gyroscopes 
  Electrical Systems 
 • History  
  Timeline 
   Launch 1990 
   Servicing Mission 1 
   Servicing Mission 2 
   Servicing Mission 
3A  
   Servicing Mission 
3B  
  New solar panels 

Replacement of the PCU 
  Nicmos returns! 
  A new coat for the telescope 
  A little boost 
  Future Servicing Missions 
  The man behind the name 
  Hubble's mirror problem 
 • Frequently Asked Questions 
 • Glossary 
 • Further Information  
  Brochures 
  Links 
  Literature 
 
Image Archive 
 • Hall of Fame 
 • Zoomable Images 
 • Wallpapers 
 • View All 
 • Top 100 
 
 Video Archive 
 • Hall of Fame 
 • Video News Releases 
 • View All 
 
 Hubble Science 
 • The Deep Fields 

• The age and size of the  
 Universe. 

 • Stellar Evolution 
 • Our Solar System 

• Black Holes, Quasars and Active  
 Galaxies 

 • Formation of Stars 
 • The Composition of the Universe 
 • Gravitational Lensing 
 • Europe & Hubble 
 
Goodies 
 • Calendar 2004 
 • Hubble Posters 
 • Wallpapers 
 • Print Layouts  
 • Best of Hubble Images 
 • Interactive Hubble 
 • How Hubble Images Are Made  

• Hubble Image Experience 
 
Pressroom 
 •  Press Kits 
 •  Embargo Site (requires 
login) 
 •  Interview Possibilities 
 •  Video formats 
 
Exercises 
 
Projects 
 • Our Web System  
  Background article about 
Simplicity (html) 
  Background article about 
Simplicity (PDF) 
  Simplicity User Manual 
(PDF) 
  Download components! 
 • FITS Liberator  
  Specifications (html) 
  Specifications (PDF) 
  Download components! 
  Educational data sets 
  Data archives 
  Submit your images 
 • IAU Working Group 
 • Science Communication Guide 
 • PR and Virtual Observatories 
 • An astronomy A/V Lab 
 • A Danish Communication  
  Strategy 
 
About Us 
 • HEIC  
  MISSION STATEMENT 
  World-class abilities 
  European-class abilities 
  HEIC Products 
  Our group 
 • Logo archive 
 • Evaluation  
  Press clippings 
  Web stats 
  Web news sites 
 • Contact Us
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Before constructing a new web site it is important to: 
- Undertake appropriate market research to understand customer 

needs  
- Plan the functionality of the web site. For example, an Image 

Archive at spacetelescope.org should: 
o Enable fast intuitive searches 
o Support mini-thumbnails (~100 per page).  
o Allow category-search with a clickable image map 
o Place simple text search directly on the first page with radio 

buttons/drop down menus the most important options  
o Provide an advanced search option for nearly all fields 

- Plan the sitemap (i.e. which Sections to include) 
- Identify the archives to be produced (images, videos etc.) 
- Plan the file formats for data in the archives (tiff, jpg, gif, .mov, 

.mpeg) and display sizes (small, medium, large etc.) to be included 
- Identify the metadata to be included with the archives - the fields 

(columns) to be included with the records (rows). 
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4 Dreamweaver 
Dreamweaver is used for maintaining all static pages as well as templates for 
the dynamic pages in the system. The central functionality used in 
Dreamweaver is its template functionality that will be described in this 
chapter. Other uses of Dreamweaver will not be described here, so for further 
information you are referrer to the Dreamweaver manual. 

4.1 Templates 

The web system relies heavily on nested templates. These are all located in 
/Templates, and have the following structure. 
 

- Global Design Template (Contains the main design: header, global 
menu and main area) 
- Global Subpage Template (Contains the design for a 

normal sub page, i.e. a sub menu area and a content area) 
- About Hubble Page (Contains the menu for the 

About Hubble subsection) 
- Exercises Page  
- Goodies Page 
- Hubble Science Page 
- Image Archive Page 
- Links Page 
- News Archive Page 
- Pressroom Page 
- Video Archive Page 
- … 

4.1.1 Templates Basics 

Areas that can be edited by the user are defined and template parameters are 
set when a template is created.  
 
An editable area: 
<!-- TemplateBeginEditable name="MainArea" --> 
<!-- TemplateEndEditable --> 

 
Template parameters (three examples): 
<!-- TemplateParam name="SelectedSection" type="text" value="home" --> 
<!-- TemplateParam name="selectedleft" type="URL" 
value="/design/menu_selected_left.gif" --> 
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<!-- TemplateParam name="unselectedleft" type="URL" 
value="/design/menu_unselected_left.gif" --> 

 
Template parameters are used in the template to define content based on the 
value of the parameter. In the following example: 
 
<img src="@@( (SelectedSection == "goodies") ? selectedleft : unselectedleft 
)@@" class="noprint" /> 

 
The image source is set to the value of the “selectedleft” template parameter 
if the value of the template parameter “SelectedSection” equals “goodies”, 
otherwise it is set to the value of the template parameter “unselectedleft”. In 
this way it is possible to create a template with a menu, where each menu item 
can be highlighted by setting the template parameter on a page that uses the 
template. 
 
A nested template is a template that is itself based on another template. For 
instance, the Global Subpage Template is a nested template of the Global 
Design Template.  
 
Parameters are can only be edited one level below the template. If, for 
instance, a template parameter Param1 is defined in Template 1, and 
Template 3 is based on Template 2 that is itself based on Template 1 then 
Param1 can be changed in Template 2, but not in Template 3. If Param1 is 
to be edited in Template 3, say, then the template parameter should be 
defined using the option passthrough=”true”: 
 
<!-- TemplateParam name="SelectedSection" type="text" value="home" 
passthrough="true" -->  

4.1.2 To edit template parameters 

  Open an html page based on the template.  
  Choose the menu item Modify > Template Properties. A window lists all 

defined parameters.  
  Edit the parameters or “Allow nested templates to control” the 

parameter by checking the option.  
  Press OK. The template will now be updated. 
  See image below. 
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4.1.3 Force an update of an html page or the whole site 

When a template is saved, either all pages using the template can be updated 
or single html pages maybe updated manually with the following:  
 

  Open the page to be updated  
  Choose the menu item “Modify > Template > Update Current Page…” 

 
All pages in the site can be updated by choosing the menu item “Modify > 
Template > Update Pages…”. This allows work in progress to be saved, but will 
only update the pages that use the template when work is complete.. 
 
When using “Modify > Template > Update Pages…” the window below will 
appear. The entire site or only files that use a specific template may be 
updated. 
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4.1.4 Making a New Section 

To add another level 1 menu point or Section, first: 
  Add the new section to the main navigation (together with other 

main sections such as News Archive, About Hubble, Hubble Science, 
Image Archive, and Goodies,.).  
 

In Dreamweaver edit the Global Design Template and switch to “Code 
View”: 

 
  Find the code block with several entries such as the one below (see also 

the image below): 
 
<td><img src="@@@( (SelectedSection == "about") ? selectedleft : 
unselectedleft )@@@" class="noprint" /></td> 
<td class="mainMenuItem@@@( (SelectedSection == "about") ? "selected" : 
"unselected" )@@@"><a href="/about/index.html" class="mainmenu">about 
hubble</a></td> 
<td><img src="@@@( (SelectedSection == "about") ? selectedright : 
unselectedright )@@@" class="noprint" /></td> 

 
Each block of code like this is a Level 1 menu item, or section. All 
items are separated by one blank line.  
 

  At the place where the section is to be inserted, make a copy of a code 
block from another section, ensuring that menu items are separated by 
one blank line in the HTML code. 
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To edit the piece of copied code:  
  Change “about” in the three places that say “SelectedSection == 

"about"” to a unique name - most logically the name of the section. 
Remember this name, as it is needed below. 
 

  Change the link in “<a href="/about/index.html" class…”. 
 

  Change the text just after the link that says “about hubble” to the text 
that should appear as the level 1 menu item in the browser. 

 
  Save the template and so update all pages that use this template. Since 

this is the Global Design Template all pages in the site use it, and will 
all be updated. 

 

 
 
The new section now needs its own template. 
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To create a new html page based on the Global Subpage Template: 
 

  Edit the template parameter “SelectedSection” to highlight the menu-
pane for the new section (see section 4.1.3). The value should be the 
name used in point 3 above.  

 
  Edit the title (for instance by adding a “- Section Name” to the title).  

 
There are two areas that can be edited: ContentArea and SubMenuArea. 
ContentArea contain the content of the pages.  
 
  Add at least one editable area by choosing “Insert > Template Objects > 

Editable Region”. SubMenuArea contains the sub-menu (see section 
4.1.5 for how to create a sub menu) 

 
  Save the file as a template (“File > Save as Template…”). 

4.1.5 Creating/Updating the submenu 

Creating or updating the submenu can be done essentially in “Design View” 
after the initial statement is inserted in “Code View”. . The easiest way to 
create a new submenu is by copying and pasting the HTML-code from another 
submenu. 
 

  Switch to “Code View” and insert the following line in top of the 
editable SubMenuArea: 

 
<!-- TemplateParam name="SelectedMenuItem" type="text" value="Default Name" 
--> 

 
  Switch back to “Design View” and create the menu using the normal 

Dreamweaver tools. A menu should look like this: 
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When using Return to go to the next line HOLD DOWN Shift, unless 
creating a list (level 3 items). This creates a <br> tag instead of a <p> 
tag. 

 
Do not be concerned with the font size/style etc. These are changed by 
Cascading Style Sheets (CSS). 

 
  Now switch to “Code View” and go to the editable SubMenuArea. 

 
  Edit each link using the following examples as a guide (menu items can 

be highlighted from a page based on this template): 
 

The Section link should look like this (add the class attribute): 
 

<a href="../link.html" class="submenuHeadline">About Hubble</a><br/> 

 
A level 2 item link should look like this (add the class attribute, 
change the two “Menu Item 1” and add &bull;&nbsp; in front of the 
link): 
 

&bull;&nbsp;<a href="../link.html" class="submenuItem@@( (SelectedMenuItem 
== "Menu Item 1") ? "Selected" : "" )@@"> Menu Item 1</a><br /> 

 
A <ul> tag should look like this: 
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<ul class=”submenuList”> 

 
A level 3 item should look like this (add the class attribute, and 

change the two Submenu Item 1s): 
 

<li><a href="../link.html" class="submenuSubItem@@( (SelectedMenuItem == 
"Submenu Item 1") ? "Selected" : "" )@@"> Submenu Item 1</a></li> 

 
Look at an existing submenu as a guide. 

4.1.6 Creating a normal page 

Choose “File > New” from the menu, and select the right template and press 
OK.  
 

  Edit the title if needed (add a “- Page Name” to the title). 
 

  Edit the template parameter “SelectedMenuItem”, to highlight the 
submenu item (see Section To edit template parameters 4.1.2). The 
value should be the unique name for the submenu item. Refer back to 
the template that the page is based on for the exact name if necessary, 
switch to “Code View” and go down to the link and locate the value. 
For instance in this submenu item: 

 
<li><a href="../fact_sheet.html" class="submenuSubItem@@( (SelectedMenuItem 
== "Fact Sheet") ? "Selected" : "" )@@">Fact Sheet</a></li> 

 
the value is “Fact Sheet” and it is located in the “SelectedMenuItem == 
"Fact Sheet"” part. 

 
  Edit the content area. 

 
  Save the page. 

 
Note: The page will not appear correctly in Dreamweaver as Dreamweaver 
cannot load the style sheet. 

4.2 Cascading Style Sheets 

The web system relies heavily on Cascading Style Sheets. There are two style 
sheets, one for normal viewing and one for printing, so special care should be 
taken when updating the style sheets. The files are located in /style/style.css 
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(for normal viewing) and /style/printstyle.css (for printing).  
 
The HTML-pages should contain the following in the header, to tell the browser 
which to use for the screen and which for printing: 
 
<link href="/style/style.css" rel="stylesheet" type="text/css" 
media="screen" /> 
<link href="/style/printstyle.css" rel="stylesheet" type="text/css" 
media="print" /> 
 
Note the media attribute. The visibility property whether items are seen on 
screen but not in print. For instance a <div>-tag containing a top image with 
lots of graphics can be hidden on the print sheet in the following way: 
 
The div-tag in the html-file: 
<div class=”header”>…</div> 

 
CSS class in style.css: 
.header { 
 position:relative;  
 width:842px;  
 height:129px;  
 background-image: url(../design/topimage.jpg);  
} 
 
CSS class in printstyle.css: 
.header { 
 visibility: hidden; 
 position:absolute; 
 top: 0px; 
 left: 0px; 
 width: 0px; 
 height: 0px; 
} 
 
Note that in the print stylesheet, the div-tag is moved to the top-left corner 
and has a width/height of zero so that it doesn’t interfere with visible 
elements. 

4.3 Synchronizing local and remote site 

One of the advantages of Dreamweaver is its excellent local/remote file 
handling, or synchronization. This keeps the local set of web files and the 
remote set on the ‘live’ server the same. An alternative is to use ftp, but 
Dreamweaver appears more user friendly. There are different options for 
synchronizing and users should experiment to find the method that suits them 
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best. 
 
Note two important issues: 

1. When synchronizing, one of Dreamweaver’s features is to change the 
timestamp on the local files to the time of upload. This makes it 
difficult to keep track of file versions etc., but cannot, to our 
knowledge, be avoided. 
 

2. If some of the folders in the web site contain a large number of files 
(more than 10,000 or 50,000), special care must be taken to avoid 
synchronizing these since it would take too long (hours). A feature 
called cloaking can make certain directories invisible, but does not 
always work. The best solution to mark and synchronize only parts of 
the web site (e.g. all directories with less than ~50,000 files). 

4.4 Special cases 

The cost/benefit issue of supporting Netscape 4.x users on Spacetelescope.org 
was investigated. It was found that an unreasonable amount of work was 
required to make the web site work on this platform, largely due to known 
bugs in Netscape 4.x’ and because the browser does not conform to globally 
accepted HTML-standards. It was decided not to support Netscape 4.x and 
instead to redirect these users to /netscape.html (as Netscape 4.x actually 
crashes if the browser window is resized while viewing the web site). 
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5 Archives: User Guide 
This chapter targets content authors who maintain the archives – the image 
and video archives are used as examples but most details apply to all other 
archives. Further information about the customisation of archives is located in 
the technical documentation (See Section 6). Knowledge of the features of 
image and video archives is a prerequisite. 

5.1 Archives 

On www.spacetelescope.org the following archives exists: 
1. Books  in /about/further_information/books 
2. Brochures placed in /about/further_information/brochures/ 
3. Calendars in /goodies/calendars/ 
4. CD-ROMs in /goodies/cdroms/ 
5. Conference Posters in /about_us/conference_posters 
6. Educational material in /kidsandteachers/education 
7. Exhibitions in /projects/exhibitions/ 
8. FITS user images in /projects/fits_liberator/fitsimages/ 
9. Images placed in /images/ 
10. Kid’s drawings in /kidsandteachers 
11. Logos placed in /about_us/logos/ 
12. Merchandise in /goodies/merchandise 
13. News placed in /news/ 
14. Newsletters in /about/further_information/newsletters  
15. Online Artwork in /goodies/art/ 
16. Postcards in /goodies/postcards 
17. Posters placed in /goodies/posters/ 
18. Print layouts in /goodies/printlayout/ 
19. Press kits in /about/further_information/presskits 
20. Slideshows in /goodies/slideshows/ 
21. Stickers in /goodies/stickers 
22. Technical documents in /about/further_information/techdocs 
23. Updates placed in /updates/ 
24. User’s videos placed in /videos/ 
25. Videos placed in /videos/user_videos 

5.2 Overview 

To publish new images and videos to the archives, follow the steps outlined 
below: 
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1. Prepare image/video files in different formats from one master file. 
2. Edit the metadata for the new image/video. 
3. Publish changes to the webserver and trigger generation of static 

pages. 
 
The image files are prepared by a fully automated process that consists of using 
a Photoshop CS2 script to generate the different display formats and put the 
files in the right directories. In contrast, video files are prepared using a 
manual process. Each image and video must be accompanied by some metadata 
such as a title and category that describes the image. The metadata is stored in 
CSV-files that can be edited with Microsoft Excel or a similar program. 
 
When the image/video files have been prepared and the metadata entered into 
the CSV-files, all the new files must be uploaded to the webserver and a static 
page that shows the image/video and any possible downloadable formats must 
be generated. The static page generation is either carried out automatically 
within 5 minutes or can be triggered immediately via an administration 
interface. 

5.2.1 Directory structure 

The only prerequisite for using the Simplicity Web System is knowledge of the 
basic directory structure of the system. 

  /bin/images.pl and /bin/videos.pl generate the dynamic indices. 
  /images/html and /videos/html contain all the static pages for both 

Spanish and English and are generated automatically. 
  /images and /videos contain folders such as thumbs, original, 180px, 

320px. These are all folders for the different display sizes and video 
formats respectively and are where the prepared files need to be 
placed. 

  /csvfiles contains the CSV-files for both the image and video archive 
and may be edited using Microsoft Excel. 

5.2.2 Naming convention 

All files related to a single image/video in the image/video archive are named 
according to a special naming scheme. A single image/video entered into the 
CSV-file has a unique id. This unique id must be used to name all the related 
files. For example, if an image has the id “heic001”, then the different display 
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sizes of the image are given names of the form heic001.jpg or heic001.tif. This 
naming scheme applies to both the image and the video archives. 

5.3 Preparing Files 

The first step in adding an image to the image archive is to generate the 
different display formats (eg, Screensize JPEG , Wallpaper 1024x768, Zoomable 
etc.). This is done using a Photoshop CS2 script and a Photoshop Droplet. Once 
the initial set up is complete, drag-and-drop the original image(s) onto the 
droplet. This will open Photoshop, make the different display formats and 
place them in the right folders. A zoomable image can also be generated in a 
simple drag-and-drop operation. 
 
NOTE: The original image/video file must be named by a unique lowercase id 
without spaces (see 5.2.2 above). The same id must be entered in the metadata 
later on. 

5.3.1 Installation of Photoshop Scripts 

To make a droplet, first install the Photoshop scripts. The following files 
should all be placed in <PHOTOSHOP ROOT>/Preset/Scripts: 

  Images.jsx 
  Videos.jsx 
  … 
  spacetelescope.jsinc 

 
Then edit both Images.jsx and Videos.jsx with a text editor such as Notepad to 
ensure that they save the new display sizes in the correct folder. The first few 
lines of the script in Images.jsx look like this: 
 
var store = "M:/llc/heicweb/images/"; 
 
#include "spacetelescopemethods.jsinc"; 
 
// Apply the script to the active document 
run( app.activeDocument ); 
 

 
The first line defines where the image folders are located. Change it to the 
right path, so, if the images folder is located on V:\simplicity\images the line 
should be changed to: 
 
var store = "V:/simplicity/images/"; 
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Note that slash is used instead of backslash and note the trailing slash. 
There must be a folder for each display size  in V:\simplicity\images. Namely: 
original, large, screen, medium, thumbs, mini, wallpaper1, wallpaper2, 
wallpaper3, wallpaperthumbs, zoom and hofthumbs. 

5.3.2 Making a Droplet 

Once the Photoshop scripts have been installed, create a droplet. To do this, 
first create a new action: 

1. Open any image. 
2. Open the action window. 
3. Press the Create new action button and name the action. 
4. Press Record. 
5. Now go to the menu File > Scripts > Images (the image formats will now 

be created for the opened image). 
6. Close the image without saving when the script is done. 
7. Press Stop Recording in the action window. 

 
Next create the droplet.  

1. Go to the menu File > Automate > Create Droplet… 
2. Choose a place to save the droplet. 
3. Choose the newly created action (changing the Set to see the action if 

necessary) 
4. Press OK to complete the droplet.  

 
Now drop one or more images onto the droplet to create all the different 
display formats. The droplet will automatically place the different display sizes 
into the correct folders in, for example: V:\simplicity\images\. 

5.3.3 Zoomifyer 

Zoomable images cannot be made with Photoshop, but a tool called Zoomifyer 
EZ can be downloaded from: 

  Windows: http://www.zoomify.com/downloads/zoomifyerEZ.zip 
  Mac OS X: http://www.zoomify.com/downloads/zoomifyerEZ.sit 

 
Drag and drop your image onto ZoomifyerEZ.exe. This will create a folder with 
same name as your image file in the same directory as the image file. Move this 
folder to V:\simplicity\images\zoom to complete the process. 
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5.3.4 Videos 

The different video formats must be created manually. The following formats 
should be made:  

  Small QT: 180 x 144 pixels, QuickTime Sorensen-3 encoded (needs 
QuickTime 4 or 5). 

  Small MPEG: 180 x 144 pixels, MPEG-1 encoded. 
  Medium QT: 360 x 288 pixels, QuickTime Sorensen-3 encoded (needs 

QuickTime 4 or 5). 
  Medium MPEG: 360 x 288 pixels, MPEG-1 encoded. 
  H.264: Full PAL format (720 x 576 pixels) MPEG-4 encoded. Can be 

played with Apple QuickTime 7. 
  Broadcast: 720 x 576 pixels, Uncompressed QuickTime or AVI, 

Broadcast quality (CCIR 601 PAL). Zipped with WinZIP. This format can 
be imported by any broadcast video editing system and edited. 

  Dome masters: For planetarium use only. 3600 x 3600 pixels, lightly 
compressed single jpeg frames produced with with a 180 degrees fish-
eye camera, or a standard 5 camera rig stitched together to a dome 
master. The dome masters can be downloaded and sliced into the 
configuration that suits the individual planetarium. 

Each video file must be named by a unique id as for the images and placed in 
the proper folder as shown in the following example: 
  
Format  Filename Folder 
Small QT id1.mov videos/180px/ 
Small MPEG id1.mpeg videos/180px/ 
Medium QT id1.mov videos/320px/ 
Medium MPEG id1.mpeg videos/320px/ 
H.264 id1.mp4 videos/h264/ 
Broadcast id1.zip videos/broadcast/ 
Fulldome As above As above + 

videos/domemaster
 
The video formats can be made “pipeline-fashion”, for instance with Cleaner XL 
from Discreet. It is possible to use different input formats, and a huge number 
of output formats, sizes, effects etc. can be chosen. It is possible to make a 
batch list of files to process overnight. The program is very fast, and has 
excellent preview functions. 
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5.4 Editing Metadata 

The metadata for the images and videos, such as id, title, caption etc. are 
stored in Microsoft Excel compatible comma-separated .csv-files (hereafter 
called CSV-files). The CSV-files are located in M:\llc\heicweb\csvfiles. The 
different CSV files are: 

1 artdata_artists.csv and artdata_pictures.csv 
2 bookdata.csv 
3 brochuredata.csv 
4 calendardata.csv 
5 cdromdata.csv 
6 conferenceposterdata.csv 
7 edumatdata.csv 
8 exhibitionsdata.csv 
9 fitsimagedata.csv 
10 imagedata.csv 
11 kidsdrawingdata.csv 
12 logodata.csv 
13 merchandisedata.csv 
14 newsdata.csv 
15 newsletterdata.csv 
16 postcarddata.csv 
17 posterdata.csv 
18 presskitdata.csv 
19 slideshowdata.csv 
20 stickerdata.csv 
21 techdocsdata.csv 
22 updatedata.csv 
23 usersvideosdata.csv 
24 videodata.csv 

 
CSV-files should be edited with Microsoft Excel (or similar), and saved in CSV-
format. There is one important issue. As commas often appear in normal text it 
is not possible to use commas as list separators and so the pipe character “|” is 
used. 
 
In order to use “|” instead of commas, set the List Separator to “|” in Control 
Panel > Regional Settings (Choosing Advanced button). This refers to Windows 
only. 
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Figure 1 A screenshot of how the metadata look in Microsoft Excel (here from 

spacetelescope.org). 

5.4.1 Metadata Fields 

All archves has some specific fields for each record, there are however a lot of 
fields common to all archives. The imagedata.csv will be used as an example to 
describe the common fields for each record: 
 

Field Description 
Id Unique identification of image. 

Image files should be named 
according to this id. 

Alternative id/OPO id  
Release number  
Release type  
Priority A number between 0 (best) and 5 

(worst) describing the quality of 
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the image. 
Release date/local 
time. 

A date and time in format 
YYYY/MM/DD HH:MM indicating 
when to release an entry 
(CET/CEST). Leave empty to 
publish immediately (normal case). 

Title Headline for image. 
Teaser  Short description 
Description Caption of image. 
Credit Copyright and name of author. 
Object Name  Name of the object(s) in the 

image. If an image depicts several 
objects, then their names are 
separated by commas. Ideally 
naming should be Simbad 
compliant. 

Object Type The object type defines the 
category to which the image 
belongs. The field MUST either be 
left empty or be one of the 
following names : 

  Solar System 
  Star 
  Star Clusters 
  Nebulae 
  Galaxy 
  Quasar/AGN/Black Hole 
  JWST 
  Cosmology 
  Miscellaneous 
  Illustration 
  Spacecraft 
  MIision 

Note: Take care to type the object 
type exactly as above. 

Mission Defines mission, e.g. Hubble 
Year  
Instrument The instrument can be left empty 

or denote the instrument used to 
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obtain the image. 
Chrono If image is part of a series of 

image, denote the number. 
Wallpaper ”yes” or ”no” 

Yes if the image should have a 
wallpaper, no if not. 

Zoomable ”yes” or ”no” 
Yes if the image has a zoomable 
image. 

Original width The width of the original image 
from which the other display sizes 
have been made. 

Original height The height of the original from 
which the other display sizes have 
been made. 

Comment  
Caption link Links to STScI pages 
Press link Links to STScI pages 

5.4.2 Editing Metadata with Microsoft Excel 

The metadata files are best edited with Microsoft Excel as this program works 
well with columns and rows of information. It has built in functions such as 
spell-checking, “fill-Down” and others that make maintenance work for the 
website easier. 
 
To enter the metadata in the CSV-file, open the CSV-file with Microsoft Excel. If 
the list separator is set up correctly each field should be shown in its own 
column. Furthermore both CSV-files start with a line defining the metadata 
fields for an image or video (this line must not be deleted). To add metadata 
for a new image or video insert a new row anywhere but the first line. 
 
When editing the fields it is easy to make “silly mistakes” and some care 
should be taken that the data are consistent. One common mistake is to 
include a space character in the object type. This is a mistake that is difficult 
to find, and the only trace is that the Perl script will return nothing when 
queried. 
 
Text formatting for fields such as teaser, description and credit can be done 
with simple html codes. The following is a small selection of codes that can be 
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used: 
  <p>sometext</p><p>sometext</p>: Will display two paragraphs, separated 

with one line of space. 
  <strong>boldtext</strong>: Text will be printed in bold. 
  <i>italicstext</i>: Text will be printed in italics. 
  <a href=”http://www.link.es”>Linktext</a>: Will create a link with the 

text Linktext referring to http://www.link.es.  
 
When closing the CSV-file in Excel be sure to save the file in CSV-format  – 
rather than the standard format preferred by Excel. 

5.4.3 Priorities and Sorting 

Perl scripts return output from the metadata files in the order that they 
retrieve them, so it makes sense to include a Priority field in the metadata, 
and to sort on this before saving the CSV-file. It is very important to do this 
sorting. An Excel macro can be created to do this. 
 
To run an existing sort macro, go to the menu item “Tools > Macro > Macros…” 
and choose the appropriate macro. 

5.4.4 Creating a Macro 

As an example we will create a macro that sorts the content of a CSV-file. First 
make sure the CSV-file is open. 
 
1. Go to a randomly chosen cell. 
 
2. Choose Tools > Macro > Record New Macro... from the menu (a new window 
opens). 
 
3. Name the macro (without white space), and choose the option Personal 
Macro Workbook  under Store macro in:. You can choose to make a shortcut for 
the macro. 
 
4. Press OK (notice that a little window with a stop-button appears). 
 
5. Perform a normal sort of the data: Press Ctrl-A to select all cells, choose Data 
> Sort… from the menu, choose the columns to sort by (and whether the sort 
is ascending or descending), and press OK in the sort window. 
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6. Press the Stop button in the little window that opened in stage 4. 
 
The macro has now been created. NOTE: Save the changes in Personal Macro 
Workbook  when Excel closes.  
 
See Section 5.4.3 on how to run the macro. 

5.5 Publish changes 

The final step in adding an image/video to the archives is to upload the files to 
the webserver and trigger the generation of static pages.  

5.5.1 Uploading Files 

All kinds of file transfer programs can be used to upload files, but 
Dreamweaver, for example, has an option to synchronise a local directory with 
a remote directory that makes the publishing process easier.  

5.5.2 Generating Static Pages 

Once the files have been uploaded a static page must be generated for each 
line added in the CSV-file. If nothing is done the pages will be generated 
within five minutes. However, to check everything is in order, page generation 
can be triggered from the administration interface located at the address 
http://www.spacetelescope.org/images/archive/admin/ or 
http://www.spacetelescope.org/videos/archive/admin/. Both addresses link to 
the same administration interface. 
 
The administration interface provides a convenient way of administering the 
static html pages of the archives. Below is a screenshot of the administration 
interface. 
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Figure 2: Screenshot of the administration interface. 

 
The administration interface has three actions: 
 

1. Run CSV-file check. 
2. Regenerate Single ID. 
3. Regenerate All IDs. 

 
For all three actions, the archive to be operated on is chosen from the drop-
down box. 

5.5.3 Run CSV-file check 

Use this action, for example, to run the generator-script immediately for a new 
CSV-file and rather than waiting five minutes for the static pages to generate 
automatically. It will check if any pages need to be updated based on the 
changes in the CSV-file. The output from the maintenance script will be shown 
below the buttons and will look something like this (one image has been 
added/updated in the image archive in this case): 
 
File changed: /si/www/catimage/simplicity/ /csvfiles/imagedata.csv... 
Starting check for new/updated/deleted ids... 
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No changes for infrared... 
Generating HTML-page for hubble... 
Generating zoomable page for hubble... 
No changes for hubble10years_eng... 
No changes for hubble10years_french... 
No changes for hubble10years_german... 
No changes for ngst... 
No changes for heic... 
No changes for archive2... 
No changes for stecf... 
No changes for factsheet... 

5.5.4 Regenerate Static Pages 

If some files have not been uploaded when a static page is generated, the 
given display sizes will not be shown on the page. However if you press Run 
CSV-file Check it will not generate a new page since the metadata has not 
changed. It is therefore necessary to force the generation of the static page, 
which can be done with the action Regenerate Single ID. 
 
Enter the id of the image/video you want to generate and press Regenerate 
Single ID. All the static pages in an archive can be regenerated, if desirable, by 
using Regenerate all IDs. 
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6 Archives: Technical Documentation 
This chapter targets those responsible for the technical maintenance of the 
image and video archive and assumes a good technical knowledge of Apache, 
Perl and UNIX system administration. The documentation gives an overview of 
the system, while more detailed documentation can be found in the source 
code. If you are not familiar with Apache or Perl the following links provide 
good structured documentation for both. 
 Perl:      

http://perldoc.perl.org 
 HTML::Template:    

http://html-template.sourceforge.net/ 
Locale::Maketext:  

http://perldoc.perl.org/Locale/Maketext.html 
 Locale::Maketext::Lexicon: 

http://search.cpan.org/~autrijus/Locale-Maketext-Lexicon-
0.62/lib/Locale/Maketext/Lexicon.pm 
http://search.cpan.org/src/AUTRIJUS/Locale-Maketext-
Lexicon-0.62/docs/webl10n.html 

 Apache:     
http://httpd.apache.org 
http://httpd.apache.org/docs/2.2/mod/mod_rewrite.html 
http://httpd.apache.org/docs/2.2/mod/mod_auth_basic.html 

 
The next chapter will focus on how to customise the system in a minor way, 
anticipating future requirements over the next couple of years and requires a 
good knowledge of the system to understand these sections. The image and 
video archive will be used as examples, but generally most things apply to the 
other archives. Please referrer to the source code, for the individual archives 
for specialized documentation on that archive. 

6.1 Notes on old archives 

On spacetelescope.org there is an ongoing transition of archives based on some 
older source code to a newer and easier maintainable source code. This chapter 
describes the new source code, however basically the functionality is the same 
though the old source code is clumsier and not so easy to maintain. Chapter 8 
will describe differences between the two systems. 
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6.2 Overview 

Generally the system consists of index pages that display search queries 
generated dynamically by user interaction. A search query can be, for example,  
browsing images in a certain category, browsing images with wallpapers or an 
advanced search. All queries are evaluated dynamically when requested by the 
user. If the user chooses to view a single image/video the user sees a static 
html page that is maintained and updated when necessary. Both the dynamic 
queries and static pages are generated from a template system and are in 
either English or Spanish. In addition, URL requests are rewritten by the 
webserver, so that, for example, 
http://www.spacetelescope.org/images/archive/top100/ is rewritten to 
http://www.spacetelescope.org/bin/images.pl?searchtype=top100. This allows 
search engines to index output generated by the Perl scripts, which would 
otherwise not be indexed. 

6.2.1 Directory Structure 

Before going into details, a general introduction to the directory structure will 
give a better overview. All paths will be referred to the root of the Simplicity 
system. Thus if the image archive is located in 
/home/web/spacetelescope/docs/ then /images refers to 
/home/web/spacetelescope/docs/images.  
 
The following directories exist in the root : 
 

/bin CGI-script directory. Contains the scripts that generate 
the dynamic index pages.  

/images Static files for the image archive. Contains both html 
files and image files. 

/videos Static files for the video archive. Contains both html 
files and video files. 

/../.. Static files for other archives. 
/simplicity Contains all data files, scripts etc. that should not be 

publicly accessible. Contains, eg, scripts for maintaining 
and updating the static html pages. 

 /csvfiles  Contains CSV files. 

6.2.2 CGI-scripts 

In /bin there are three scripts and two symbolic links: 
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images.pl CGI-script for index page generation for the 
image archive. 

embargoimages.pl Symbolic link to images.pl for the embargoed 
image archive. 

videos.pl CGI-script for index page generation for the 
video archive. 

embargovideos.pl Symbolic link to videos.pl for the embargoed 
video archive. 

admin.pl Administration interface for, eg,  forcing the 
regeneration of static html files. 

6.2.3 Simplicity files 

In /simplicity there are several important directories and files. 
data/ Contains temporary data and log files that 

enable intelligent decision-making about 
updates to a static page. Also contains compiled 
templates to speed up page generation based on 
templates. 

installation/ Contains configuration files and scripts make 
Simplicity easier to install.  

lib/ Contains Perl modules that are common to the 
different scripts in Simplicity. However the Perl 
modules should only be available for the Perl 
scripts in Simplicity and not system-wide. 

locale/ Contains language lexicons that make 
localisation of the Perl-scripts easier. 

scripts/ Contains scripts to maintain the static files 
automatically. 

webauth/  Password files to protect embargo pages. 
webtemplates/ Contains template files for page design. 

6.2.4 Static files 

All the static files are located in /images and /videos. Files in these directories 
are automatically updated by the system. Furthermore both /images and 
/videos contain some folders for the all the different display formats and 
videos. 
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6.3 Installation and Requirements 

Simplicity can be installed on most Unix systems and requires Perl version 5.8 
plus the following Perl modules: 
 

CGI    (core module) 
Digest::MD5   (core module) 
Exporter   (core module) 
Time::Local   (core module) 
URI::Escape   (download from CPAN) 
HTML::Entities  (download from CPAN) 
Parse::RecDescent  (download from CPAN) 
Inline::C   (download from CPAN) 
Locale::Maketext  (core modules from Perl version 5.8) 
Locale::Maketext::Lexicon (download from CPAN) 
HTML::Template  (download from CPAN) 
HTML::Template::JIT (download from CPAN) 
HTML::Strip   (download from CPAN) 
Text::CSV_XS  (download from CPAN) 
Parse::CSV   (download from CPAN) 

 
   
The core modules are included in the Perl distribution while the other modules 
need to be downloaded and installed in their latest versions from CPAN 
(http://search.cpan.org). Locale::Maketext::Lexicon includes a script 
xgettext.pl that also needs to be available in the system path for execution. 
 
Simplicity requires Apache version 1.3.x or 2.x.x with the option to use 
rewrites, authentication. The program msgfmt - from gettext (see 
http://www.gnu.org/software/gettext/gettext.html) must compile the 
localisation files to byte-code to localise the Perl scripts.  

6.3.1 Webserver configuration 

The webserver configuration is in two stages. The configuration that needs to 
be inserted into the correct virtual host is located in 
/simplicity/installation/ServerSetup.txt. It is especially important that the 
rewrites are located in the virtual host configuration and not a, for example, 
.htaccess file, since Apache will apply its own rewrites before passing control to 
the rewrites in .htaccess (this is avoided by placing them in the virtual host 
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instead). Furthermore it is important that some rewrites (see the file) have 
[PT] after the pattern, to allow the request to pass through other handlers. 
Likewise it is important that AuthConfig and Limit can be overridden to allow 
.htaccess files to be generated dynamically to password protect embargo pages. 
Second, certain directories such as /simplicity/ deny public access by use of 
.htaccess files. 
 
Further documentation on rewrites can be found in the Apache documentation. 

6.3.2 Perl Modules 

The newest versions of the Perl modules can be downloaded from 
http://search.cpan.org (search by name) and installed by running the 
following command in each of the downloaded and expanded directories. 
 
perl Makefile.PL 
make    
make install 

 
or by using  
 
sudo perl -MCPAN -e 'install HTML::Template::JIT' 

6.3.3 Permissions 

The system is fairly sensitive to permissions issues. If some files have the 
wrong permissions, they may not be overwritten and the system will seem to 
be broken. Correct permissions can be set on the necessary files and folders by 
running the script /simplicity/installation/modify_permissions.sh. In particular, 
the files /simplicity/data, /images/html and /videos/html must be writeable by 
both the user running the cron-scripts and the webserver user. This is best 
achieved by putting the cron-script user and the webserver user into the same 
group and making files writable by the file owner and the file owners group. 

6.3.4 Cronjob 

The following cronjob needs to be run on the server by the same user as the 
webserver user. 
 
00,05,10,15,20,25,30,35,40,45,50,55 * * * * cd 
/net/ttwww/si/www/catimage/simplicity/scripts/; /usr/bin/perl 
up2datecheck.pl –A images; modify_permissions.sh 1>/dev/null 
 
00,05,10,15,20,25,30,35,40,45,50,55 * * * * cd 
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/net/ttwww/si/www/catimage/simplicity/scripts/; /usr/bin/perl 
up2datecheck.pl –A videos; modify_permissions.sh 1>/dev/null 

6.4 System Modules 

Common Perl modules for all the scripts are located in 
/simplicity/lib/Simplicity. This is a list of the modules with a brief description: 
 Archive/Images.pm Image archive specific routines and definitions. 
 Archive/Videos.pm Video archive specific routines and definitions. 
 IndexTools.pm Generation of, eg, the Google navigation bar. 
 L10N.pm  Sets up of script localisation. 
 Search.pm  Routines for searching the CSV-files. 
 Site.pm  Global site definitions of various paths. 
 Tools.pm  Routines for easy generation of static pages. 

6.4.1 Template System  

The Perl scripts that produce the output use the template system 
HTML::Template::JIT that is an extension of HTML::Template that compiles 
the templates to native byte-code for faster execution. The compiled templates 
are stored in /simplicity/data/compiled_templates. The actual templates are 
located in /simplicity/webtemplates/en and /simplicity/webtemplates/es 
depending on their language. The template language is straightforward and is 
documented on http://html-template.sourceforge.net so only a brief example 
will be given here.  
 
Basically the contents of a variable can be inserted with:  
 
<tmpl_var name=”variable_name”>  

 
The above template code will require that the variable name variable_name is 
set somewhere in the code by the following Perl code: 
 
$tpl->param(‘variable_name’ => <somevalue> ); 

 
The templates are set up in images.pl, videos.pl, staticimages.pl, staticvideos.pl 
and IndexTools.pm. Each of the scripts creates a template instance in the 
variable $tpl.  It is obvious from the scripts which main template file they use. 
The main template file may include other template files and conditional 
statements and is thus very simple, yet powerful, to use. 
 
The template system should be able to detect changes to the template files and 
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recompile the templates. However, this doesn’t always work when templates 
included in the main template are updated. Therefore the compiled templates 
can be cleared from the administration interface. The first time a script is 
accessed after clearing the cache, the script will need to compile a new 
template. This compilation will take several seconds, but is a one time 
operation. 

6.4.2 Locale System 

The locale system uses the Perl modules Locale::Maketext and 
Locale::Maketext::Lexicon to translate the text located inside the Perl scripts 
more easily. Most text should be located in the templates and therefore be easy 
to translate, but inevitably some text must be located in the scripts, which is 
where the locale system comes in handy. 
 
Localising a script consists of: 

1. Loading the necessary modules (that is Simplicity::L10N). 
2. Marking strings that need to be translated. 
3. Extracting strings that need translation from scripts. 
4. Inserting the strings into a common lexicon. 
5. Translating the strings in the lexicon. 
6. Compiling the lexicon to machine code. 

 
Marking strings 
To localise a script, load the module Simplicity::L10N and, somewhere in the 
script, before the localised strings, make a call to:  
 

Simplicity::L10N::setLanguage( 'en' ); 

 
Afterwards mark a string for localisation by using the routine loc(). So, for 
example, to localise the string “Results for $text” write: 
 
 loc('Results for [_1]',$text) 

 
This example also shows how to include variables in the string by use of [_1]. 
For most cases just surround the string with the loc function. 
 
The function loc will replace the text with the translated text. Sometimes the 
text will have to be translated later, for example if calling loc($text) where 
$text contains a string. This string should not be translated when given to loc, 
as loc will try to translate the string. However the string still needs to be 
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inserted into the lexicon. So, to mark a string for translation, but return the 
original string instead of the translated string, call the routine translate 
instead. For an example of its use see ImagesArchive.pm. 
  
Extracting strings 
Strings are extracted by the external program xgettext.pl as part of the 
Locale::Maketext::Lexicon module. The program is called from the command 
line:  
 
xgettext.pl -o=simplicity/locale/es/messages.po \ 

 -f=simplicity/installation/localizefiles.txt \ 
  -D=bin \ 
  -D=simplicity/lib/Simplicity \ 
  -D=simplicity/scripts 

 
 This tells xgettext.pl to put a lexicon in the Spanish directory 
/simplicity/locale/es/messages.po, to read localizefiles.txt for files that need to 
be parsed for marked strings and that the files are located in three possible 
directories (by use of the –D option). This step needs to be repeated in the 
English directory to create both an English and a Spanish lexicon.  
 
The above command will create the file /simplicity/locale/es/message.po and 
/simplicity/locale/en/message.po. If the files are already there, they will be 
updated with any new strings. This ensures that if the string has already been 
translated, it will just be reused instead of inserting a new string. 
 
Translation of lexicons 
The messages.po files will contain a long list of entries similar to this: 
 
#: simplicity/scripts/staticimages.pl:104 
msgid "Images" 
msgstr "Imágenes" 

 
If the string has not yet been translated, msgstr will be an empty string. The 
comment above msgid shows the translator where the strings were extracted 
from. All the empty msgstr have to be filled out to translate the lexicon. 
 
Compilation of Lexicon 
Once the lexicon has been translated, it must be compiled to machine code by 
the program msgfmt from gettext. This program is usually installed on most 
Unix development systems. To compile a lexicon, just run the following 
command: 
 



“Simplicity” on SpaceTelescope.org 

 

41 
msgfmt -o simplicity/locale/es/messages.mo simplicity/locale/es/messages.po 

 
The process of extracting strings and running xgettext.pl and msgfmt has been 
automated by the script /simplicity/installation/localize.sh. This script will 
extract strings with xgettext.pl and compile the lexicon in one step. So, if new 
localised strings have been added, run localize.sh once, translate the lexicon 
and run it one more time. 

6.4.3 Search Modules 

The Perl module Search.pm is responsible for all searches in the CSV-files. It 
uses code references and anonymous subroutines to make implementation 
simpler and more structured. It is strongly recommended that readers make 
sure they understand code references and anonymous subroutines before 
continuing. Further information can be found at the following to URLs: 
 http://perldoc.perl.org/perlsub.html 

http://perldoc.perl.org/perlref.html 
 
Basically there are four main routines in Search.pm. First, the subroutine 
findId will look up a single id in a CSV-file. Second, the subroutine search will 
look up several rows matching a given condition. Third, the subroutine 
parseQuery will parse a query string to make an abstract representation suitable 
for the fourth subroutine freesearch to find matching rows. Furthermore the 
parseQuery function will expand the query for certain astronomical search 
terms, to allow for better searching.  
 
Both findId, search and freesearch will make calls to a function splitRow that 
is defined in either ImagesArchive.pm or VideosArchive.pm depending on the 
current archive. The function splitRow defines the fields for the CSV-files. 
 
Search Queries 
The query parser will parse search queries from the keyword search and the 
advanced search “by string”. The following is an example of the syntax of a 
search query (a grammar is given in the source code for Search.pm)  
 
+Pluton –Charon M51 “Some Phrase”  

 
Basically a search query consists of mandatory and non-mandatory terms (no 
sign), where mandatory terms can be inclusive (plus sign) or exclusive (minus 
sign). A term is a single keyword or phrase. In the above example there are 
four search terms. All mandatory conditions are checked to hold first, meaning 
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that all inclusive terms have to be in a single entry (a row in the CSV-file) and 
at the same time all exclusive terms must not be in a single entry. Then all 
non-mandatory terms are checked. All non-mandatory terms require that at 
least one of the terms needs to be in a single entry to have the entry included 
in the search result. 
 
 
Query Expansion 
Queries are expanded using terms like M51 and NGC 3370 since both the 
concatenated version and spaced version may exist in the CSV-file and should 
be found. The query expansion will expand a single term like M51 or ‘M 51’ 
(notice the quotes which make it a single term) to the two terms ‘M51’ and ‘M 
51’. So 
 
 M51  => ‘M51’ or ‘M 51’ 
 ‘M 51’ => ‘M51’ or ‘M 51’ 
 
This will expand the search field and include more entries in the final search 
result since we search on more terms (boolean OR). Furthermore if two search 
terms in a row match a certain pattern, eg,. M 51, the query parser will narrow 
the search field. Notice that M 51 is two search terms namely M and 51. If two 
search terms in a row match a given pattern it will be expanded. Example: 
   
 M 51 => ‘M51’ or ‘M 51’ 
 
This narrows the search field by using more specific terms. We concatenate two 
search terms to produce two more specific search terms. This will result in 
fewer entries in the final search result. 

6.4.4 Archive Modules 

The two archive modules Images.pm and Videos.pm contain source code specific 
to the image and video archives respectively. Paths to data files, output 
directories, dependent templates etc. are all located in the archive module for 
the respective archive. Furthermore subroutines that define the fields in the 
CSV-file, process up-to-date checks and generate static pages etc. are also 
located in the archive modules. Specific details will not be given here, since all 
subroutines and variables are used in some other module/script where they will 
be explained. 
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6.5 Scripts 

The two modules Tools.pm and IndexTools.pm are used in the scripts 
responsible for static page generation, up-to-date checks and index page 
generation. These scripts and the roles of the two modules will be described in 
this section. 

6.5.1 Index Page Generation 

Index page generation is performed by the scripts /bin/images.pl and 
/bin/videos.pl respectively. Essentially the following happens in the script: 

1. Initialisation: 
a. Path set up. 
b. Parameter extraction from query. 
c. Localisation set up. 

2. Selection of index layout based on parameters. 
3. Generation of search condition based on parameters. 
4. Search and retrieve results. 
5. Pass results and other values to template system for displaying to 

user. 
 
The script takes the following parameters: 

searchtype Determines which kind of search to perform: a Hall of 
Fame search, Advanced search, Keyword search, Top 100 
search etc.  

 viewtype The main index layout type to use. Defaults to standard. 
string  A query string whose meaning depends on searchtype. 
from The image/video number that the index page must 

contain (for browsing results). 
lang One of the values en or es for English/Spanish (defaults 

to en). 
 
Index Layout 
The initialisation process just ensures that the proper modules are loaded and 
that parameters have been extracted. Afterwards the index layout is set up to 
allow for different layouts of the index pages for example for Hall of Fame, 
View All, Wallpaper and Normal View. Since an index layout can probably be 
used for both the image and video archive, the module IndexTools.pm defines a 
list of index layouts, namely: 
  

wallpaper_viewall 
 wallpaper 
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zoomable_viewall 
zoomable 
bestof 
videosbestof 
videosstandard_viewall 
videosstandard 
standard_viewall 
standard 

 
All layout types are defined in IndexTools.pm with number of rows, number of 
columns and whether to use one, two or three html table rows for each row of 
results. This allows the template system to first make an html table row with 
images and then a row with image titles before continuing to the next row of 
results. The html code for each index is defined in 
/simplicity/webtemplates/en/indicies.tpl (English version). 
 
Search Condition 
The search condition for each search type might look like this: 
 
$condition = sub { $row::wallpaper eq "yes" }; 

 
This creates an anonymous subroutine that is called for each row in the CSV-
file. The subroutine must return TRUE to have a row included in the search 
results (note that if no return statement is present, then the return value is 
defined by the last statement in the subroutine). Inside the subroutine the 
individual fields can be accessed by $row::<fieldname>. Hence, in the example 
above, all rows in the CSV-file having yes as a value for the field wallpaper will 
be included. Alternatively, a limit condition can also be specified to retrieve 
only a certain number of rows (this should however only be used when the 
status bar is not shown as in Hall of Fame searches). 

6.5.2 Up-to-date Checks 

If the website has many simultaneous hits, static pages are generated for all 
entries in the archives to reduce the CPU load. Up-to-date checks of the static 
pages are performed by the script /simplicity/bin/up2datecheck.pl.  
  
The script is run every 5 minutes to check if it needs to generate a new set of 
static pages for a given archive. Furthermore the script can be run manually 
from the command line with the following options: 
 
Usage: up2datecheck.pl [options] 
   -o              trigger CSV-file check 
   -a              generate all pages 
   -A [archive]    archive to check 
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If no archive is given nothing happens. It is important to note that 
up2datecheck.pl only runs checks against the CSV-file and not the actual 
image/video files. Hence, if a user has forgotten to upload a broadcast video, 
the script will not regenerate the static page even though it is outdated. The 
administration interface described in the user guide (see Section 5.5.2) uses 
this script and should be used in preference to the command line version since 
it might cause permission issues on the generated files if the command line 
version is used.  
 
The script keeps track of changes in a couple of ways. File modification times 
are monitored, so if the files used by a static page are changed, an update 
check will be carried out. Essentially changes to the templates files and scripts 
that generate the static pages will result in the regeneration of all static pages 
in an archive. However if a CSV-file has been modified the script will only 
regenerate the static pages for which the data has changed. 
 
To detect if a row has been edited the script saves a checksum for the row and 
compares this checksum with the new checksum next time it runs. If a row has 
not been changed, its checksum will be the same.  
 
A list of embargoed entries together with the release date for each archive is 
also maintained to trigger regeneration and removal of password protection 
when the release date has been passed. 
 
The scripts also generate an .esoacc file that denies access to embargoed 
entries. It is generated on the basis of a template located in 
/simplicity/scripts/templates/htaccess.tpl and looks like: 
 
<Files ~ "(IDLIST)\.(EXTLIST)"> 
AuthType Basic 
AuthName "Embargo Images and Videos" 
   
AuthUserFile /home/web/spacetelescope/docs/simplicity/webauth/webauthusers 
AuthGroupFile /home/web/spacetelescope/docs/simplicity/webauth/webauthgroups 
require group embargos admins 
</Files> 
 

IDLIST is replaced by a list of embargoed entry ids, and EXTLIST is replaced by a 
list of extensions (typically html, txt, doc, pdf, jpg, gif, tif and zip) specific for 
each archive (defined by the variable $Simplicity::EXTLIST in the archive 
modules). 
 



“Simplicity” on SpaceTelescope.org 

 

46 

If an entry (image/video) is removed from the CSV-file, the corresponding 
static html page is also deleted. All non-generated files in output directories 
will also be deleted, unless they begin with a full stop like .esoacc. 

6.5.3 Static Page Generation 

The up2datechecks.pl script, as described in previous section, controls the 
generation of static pages. The script will use the subroutines generatePage, 
updateCheck and initUpdateCheck defined in the archive modules to determine if 
the proper files exist and generates a static page if up2datechecks.pl finds it 
necessary to update a page. 
 
Both the image and video archive will rely on the scripts staticimages.pl and 
staticvideos.pl in the generatePage subroutine to generate a single static page. 
Both scripts are quite simple as they only extract a row from the CSV-file and 
pass the values on to the template system. The two scripts use a small set of 
subroutines in the module Tools.pm to allow hashes for the template system to 
be created more easily. 

6.6 Photoshop Scripts 

The User Guide (Section Error! Reference source not found.) documents how 
to install and use Microsoft Excel, Photoshop and a file transfer tool for archive 
administration. More detailed information on the inner workings of the 
Photoshop scripts is given here.  

6.6.1 Images Display Formats 

The website Spacetelescope.org uses 17 different image display sizes. 
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Figure 3 Here two of the different image display sizes are seen (News to the left, and Newsmini 

to the right). 
 
The different display sizes that are generated from the original images are (W x 
H in pixels): 

1. original: “Fullsize original” (tiff/jpg/gif). No colour correction. 
Original colour profile embedded. 

2. large: “Large jpeg” (orig x orig), jpeg quality 80. No colour 
correction. Original colour profile embedded. 

3. PublicationTIFF: 4000 pixels. No colour correction. Original 
colour profile embedded. 

4. PublicationJPEG: 4000 pixels. No colour correction. Original 
colour profile embedded. Jpeg quality 90. 

5. screen: “Screensize jpeg” (1280 x *), jpeg quality 60. Unsharp 
mask radius 1, Threshold 0, Amount 25. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 

6. medium: “Medium jpeg” (320 x *), jpeg quality 60, unsharp 
mask radius 1, Threshold 0, Amount 70. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
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colour profile is unknown, no correction is applied and no 
profile is embedded. 

7. thumbs: “Thumbnail jpeg” (max(x,y) = 122), jpeg quality 45, 
unsharp mask radius 1, Threshold 0, Amount 80. If the colour 
profile of the Original image is either AdobeRGB or LStar-RGB, 
the image is colour corrected manually and no profile is 
embedded. If the colour profile is unknown, no correction is 
applied and no profile is embedded. 

8. mini: “Mini jpeg” (max(x,y) = 50), jpeg quality 45, unsharp 
mask radius 1, Threshold 0, Amount 80. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 

9. wallpaper1: “Wallpaper 1024 x 768”, jpeg quality 80. Unsharp 
mask radius 1, Threshold 0, Amount 25. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 

10. wallpaper2: “Wallpaper 1280 x 1024”, jpeg quality 80. Unsharp 
mask radius 1, Threshold 0, Amount 25. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 

11. wallpaper3: “Wallpaper 1600 x 1200”, jpeg quality 80. Unsharp 
mask radius 1, Threshold 0, Amount 25. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 

12. round: image for the front page (82 x 82), transparent gif, 
perceptual, 256 colour, no dither, pattern dither transparency. 

13. news: (180 x *), jpeg quality 53, unsharp mask radius 1, 
Threshold 0, Amount 50. ImageReady. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 



“Simplicity” on SpaceTelescope.org 

 

49 

14. zoom: No options, produced with Zoomifyer EZ v3.0.exe. 
15. wallpaperthumbs: “Thumbs 122 x 92 pix” created from 

wallpaper1 jpegs, jpeg quality 45, unsharp mask radius 1, 
Threshold 0, Amount 80. If the colour profile of the Original 
image is either AdobeRGB or LStar-RGB, the image is colour 
corrected manually and no profile is embedded. If the colour 
profile is unknown, no correction is applied and no profile is 
embedded. 

16. newsmini: (60 x *), jpeg quality 45, unsharp mask radius 1, 
Threshold 0, Amount 80. If the colour profile of the Original 
image is either AdobeRGB or LStar-RGB, the image is colour 
corrected manually and no profile is embedded. If the colour 
profile is unknown, no correction is applied and no profile is 
embedded. 

17. hofthumbs: For Hall of Fame (95 x *), jpeg quality 45, unsharp 
mask radius 1, Threshold 0, Amount 80. If the colour profile of 
the Original image is either AdobeRGB or LStar-RGB, the image 
is colour corrected manually and no profile is embedded. If the 
colour profile is unknown, no correction is applied and no 
profile is embedded. 
 

These different display sizes are generated with the help of Photoshop CS2’s 
built-in Javascript facility. A small script (for instance Images.jsx) calls 
another script (spacetelescopemethods.jsinc) that contains recipes for how 
every display size on the entire website is created for each archive. For 
instance, the script that creates the 15 main images that are used in the image 
archive, Images.jsx, looks like this: 
 
var store = "M:/llc/heicweb/images/"; 
 
 
#include "spacetelescopemethods.jsinc"; 
 
 
// Apply the script to the active document 
run( app.activeDocument ); 
 
 
/** 
 * Runs the image processing steps 
 * @param document Document to process. 
 */ 
function run(document) { 
    var originalState = document.activeHistoryState; 
    var originalUnit = app.preferences.rulerUnits; 
    app.preferences.rulerUnits = Units.PIXELS; 
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// Flatten the image, change mode to 8-bit RGB 
    document.flatten(); 
    document.changeMode( ChangeMode.RGB ); 
    document.bitsPerChannel = BitsPerChannelType.EIGHT; 
// Copy he original image into the original folder 
    copyOriginal( document ); 
// Generate all 12 thumbnails except Round 
    processThumbnails( document ); 
// Go back to the original state 
    document.activeHistoryState = originalState; 
// Flatten the image, change mode to 8-bit RGB to prepare for other actions   
    document.flatten(); 
    document.changeMode( ChangeMode.RGB ); 
    document.bitsPerChannel = BitsPerChannelType.EIGHT; 
    app.preferences.rulerUnits = originalUnit;     
} 

 
The script calls spacetelescopemethods.jsinc, which starts like this: 
 
var lstarString = "Lstar-RGB.icc"; 
var adobergbString = "Adobe RGB (1998)"; 
 
 
var Algorithm = { 
    None       : 0, 
    Crop       : 1, 
    ResizeWidth: 2, 
    ResizeBox  : 3, 
    Resize4kpx : 4 
}; 
 
/** 
 * Defines a function that can be make new display formats with. 
 */ 
function Thumbnail( a, w, h, s, u, n, q, argbsat, argbB, argbG, argbW, 
lstarSR, lstarHY, lstarHB, lstarB, lstarG, lstarW ) { 
    return { 
        algorithm   : a, 
        width     : w, 
        height   : h, 
        sharpen     : s, 
        unsharpen   : u, 
        name   : n, 
        quality    : q, 
        AdobeRGBSatMaster   : argbsat, 
        adobeRGBBlackLevel  : argbB, 
        adobeRGBGamma     : argbG, 
        adobeRGBWhiteLevel  : argbW, 
        LStarSatRed         : lstarSR, 
        LStarHueYellow     : lstarHY, 
        LStarHueBlue     : lstarHB, 
        LStarBlackLevel     : lstarB, 
        LStarGamma          : lstarG, 
        LStarWhiteLevel     : lstarW 
    }; 
} 
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// Define default values 
var defaults = [ 
0, //defAdobeRGBSaturationMaster 0 
0, //defAdobeRGBBlacklevel   1 
1.0,  //defAdobeRGBGamma  2 
255,  //defAdobeRGBWhitelevel  3 
0, //defLStarSaturationRed  4 
0, //defLStarHueYellow  5 
0, //defLStarHueBlue  6 
0, //defLStarBlacklevel  7 
1.0,  //defLStarGamma   8 
255   //defLStarWhiteLevel  9 
]; 
 
// Parameters for every display size except original and zoom.  
// The proper display format is called by an index from 0-10 
// Compare these with the description of the display sizes. The one  
// showed below is the screen display format. 
var thumbnails = [ 
Thumbnail( Algorithm.ResizeWidth, 1280, 0, false, 25, "screen" , 60, 5, 8, 
0.96, 255, 6,  -5,  5,  5,0.95, 255  ), 
… 
]; 

6.6.2 Video Display Formats 

The website uses five different types of main videos: 
 

1. Small QT: 180 x 144 pixels, Quicktime Sorensen-3 encoded (needs 
Quicktime 4 or 5). 

2. Small MPEG: 180 x 144 pixels, MPEG-1 encoded. 
3. Medium QT: 360 x 288 pixels, Quicktime Sorensen-3 encoded (needs 

Quicktime 4 or 5). 
4. Medium MPEG: 360 x 288 pixels, MPEG-1 encoded. 
5. H.264: Full PAL format (720 x 576 pixels) MPEG-4 encoded. Can be 

played with Apple Quicktime 7. 
6. Broadcast: 720 x 576 pixels, Uncompressed Quicktime or AVI, Broadcast 

quality (CCIR 601 PAL). Zipped with Winzip. This format can be imported 
by any broadcast video editing system and edited.  

7. Dome masters: For planetarium use only. 3600 x 3600 pixels, lightly 
compressed single jpeg frames produced with with a 180 degrees fish-eye 
camera, or a standard 5 camera rig stitched together to a dome master. 
The dome masters can be downloaded and sliced into the configuration 
that suits the individual planetarium. 

 
The video formats are made “pipeline-fashion” with Cleaner XL from Discreet. 
It is possible to use different input formats, and a huge number of output 
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formats, sizes, effects etc. can be chosen. It is possible to make a batch list of 
files to process overnight. In addition the program is very fast, and has 
excellent preview functions. 
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7 Archives: Technical Customisation 
This chapter assumes knowledge of the content of the previous chapter and 
will mainly focus on what to remember when making small changes to 
Simplicity. Common to all changes is that modifications to the Perl scripts will 
probably require new lexicons and translations. That is, run 
/simplicity/installation/localize.sh once, translate the message.po files and run 
localize.sh again (see 6.4.2). 

7.1 New Field in CSV-File. 

Adding a new field in the CSV-file primarily requires that the routine that split 
a row in the CSV-file is updated. This subroutine is called splitRow and is 
located in either Images.pm or Videos.pm depending on which archive is being 
changed. The most important part is that the fields are defined in the same 
order in the splitRow subroutine as they appear in the CSV-file. 
 
To display the newly added field on the static page, update staticimages.pl or 
staticvideos.pl by adding the field as a template variable. The place to be edited 
in the source code will look somewhat like this, where the new field newfield 
has been added: 
 
# Setup field names 
$tpl->param( "ID" => $row::id, 
   "PRIORITY" => $row::priority, 

  “NEWFIELD” => $row::newfield,  

 
Remember that some fields used to display text on the static pages must be 
localised and thus require two separate fields. 

7.2 New Image Category/Instrument 

Adding a new instrument to the list of possible instruments means editing 
/images/search.html (note this only applies to the image archive). Find the 
drop-down box for the instrument list and add the new instrument. The value 
of the option is the value that must be used in the CSV-file. 
 
Adding a category requires more steps (applies to both the image and video 
archive).  
 
1. First edit Images.pm, to add a new category/subcategory to the variable 
%Simplicity::ImagesArchive::Categorization which looks like this: 
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%Simplicity::ImagesArchive::Categorization = ( 
   translate('Solar System') => [translate('Planets'),translate('Sun')], 
   translate('Nebulae')  => [], 

 
The name used above for the category must be the same as the one used in the 
CSV-files. 
 
2. Next ensure that there is a translation for the category. This is done by 
running /simplicity/installation/localize.sh, then translating the category in 
the messages.po files for both English and other languages, then running 
/simplicity/installation/localize.sh again (see 6.4.2 for more details on 
translation). 
 
3. Edit /images/search.html.en. First add the new category to the drop-down 
box. Use lowercase for the value of the option tag, as in: 
 
<option value="new category">New Category 

 
Next add the category to the JavaScript array to the top of the file by using 
the examples below. 
 
store['new category'] = new Array( ); // Without sub-categories 
 
store['new category'] = new Array( // With sub-categories 
 'All', 
 'all', 
 'New Subcategory', 
 'new subcategory' 
 ); 

 
If there are no subcategories, just add the first line. If there are subcategories, 
then ensure that both the subcategory and “all” subcategory exist as shown in 
the example above. Each subcategory has two elements in the array. First 
element defines the displayed text and should be localised, while the second 
element is not localised and should match the subcategory added in step 1 (in 
lowercase). 
 
4. Lastly add the category/subcategory to the category overview page 
/images/index.html. Use one of the links below to display an index page for 
the category/subcategory (remember to change en to es for the Spanish 
version). 
 

archive/subtopic/new+subcategory/ 
archive/topic/new+category/ 



“Simplicity” on SpaceTelescope.org 

 

55 

 
Notice that space is replaced by + signs.  

7.3 New Image Formats 

To add new image display formats:  
a. Update the Photoshop script and create a new droplet. 
b. Make a folder for the display format. 
c. Update staticsimages.pl to show the new format on static 

pages. 
 
Add the new display format to the thumbnails array in the top of the 
Photoshop script, /simplicity/installation/clients/spacetelescopemethods.jsinc. 
 
Thumbnail( Algorithm.ResizeWidth,  122,    0, false, 80, "thumbs_new"         
, 45,  5,  8, 0.96, 255, 6,  -5,  5,  5,0.95, 255, false  ),//2 

  
This creates a display format that is 122 pixels wide and keeps that aspect 
ratio. The image will be saved in the folder thumbs_new, so create the directory 
/images/thumbs_new. The rest of the parameters can be tweaked as necessary. 
Refer to section 6.6.1 for more information on the different display sizes that 
might help to customise the new format.  
 
Next create a variable index_thumbs_new to hold the index of the newly added 
element to the thumbnails array. Insert the variable index_thumbs_new in the list 
in the makeImages function. When the spacetelescopemethods.jsinc script has 
been edited remember to distribute to all client machines and create new 
droplets (see 5.3.2). 
 
Last, the display format should be added to the static pages by editing 
staticimages.pl. This is done by adding the following code next to the other 
downloads. 
 
addDownload( \%images,   // Section to add download to. 
  loc('Thumbs New'),  // Display name, 
  "thumbs_new",   // Folder. 
  "jpg",    // Image extension 
  "images",    // Icon to use 

  $Simplicity::LOCALDIR,  // Always the same 
  $Simplicity::LOCALURL,  // Always the same 

   1 );    // Use special massive warning 

 
The last parameter 1, is used on large files to check whether the pixel size is 
above 4000x4000 pixels instead of only 20 MB. Remember to localise the script 
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afterwards.  

7.4 New Video Formats 

Adding a new video format requires more files to be updated than when adding 
new image display formats. First decide if the new format should be 
downloadable only, or also have a play page. If the video is to be downloadable 
only thrn go through nearly the same steps as for new image formats. Just edit 
staticvidoes.pl, not the Photoshop script. Formats with a play-page should also 
go though this step. 
 
Basically only the following lines are needed to add the new video format to 
the html pages. 
 
addVideo( \@videos,     

  loc('Large H.264 MPEG-4'),  // Title (localized) 
  'mp4',     // Playable format. 
  'mp4',     // Downloadable format. 
  'h264',    // Folder/Size.  
  'qt',     // Icon. 
  0,     // 1 if has play page, 0 else. 
  $Simplicity::LOCALDIR,  // Always the same. 
  0,     // Tell template to show 

special note (currently: For TV use only!) 
  0);    // 1 if playpage exists but 

only in one size, 0 if both small and medium exists. 

 
If the video format is only downloadable - as in the above example - remember 
to create the folder /videos/h264 and add the extension to (mp4) to the 
variable $Simplicity::EXTLIST in Videos.pm. 
 
If the video format is to have play-pages, then additional steps are required: 

1. Add the format to the variable @PlayVideoFormats in Videos.pm if it 
there are both a small and a medium version. 

2. Add the format to the variable @PlayVideoFormatsNoSize in 
Videos.pm if there is only one size version. 

3. Create directories to html play-pages and datafiles. For two-size 
video formats (small/medium) create 
/videos/html/180px/newformat and 
/videos/html/320px/newformat. For one-size video formats create 
/videos/html/newformat and /videos/newformat_folder. 

 
Last, add a template variable in staticvideos.pl for the play-page: 

 
'newformat_playpage' => ($version eq 'format_ext') 
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and update the templates /simplicity/webtemplates/en/video.tpl and  
video_embargo.tpl to display the new play-page. Remember to localise the Perl 
scripts. 

7.5 New Index Type 

To add a new index layout type, first update IndexTools.pm with the new index 
type: 
 

elsif( $layout eq 'new_layout_type' ) { 
  $Simplicity::Index::TableCols = 4; 
  $Simplicity::Index::TableRows = 3; 
  $Simplicity::Index::IndexLayout = 'new_layout_type'; 
  $Simplicity::Index::UseTitleRow = 1; 
  $Simplicity::Index::UseAdditionalRow = 0; 
 } 

 
1. The variable IndexLayout describes the name of the index layout and is 

used to include the proper index template in the template indices.tpl.  
2. Next, edit indices.tpl and add the line: 

 
<tmpl_if name="index_new_layout_type"><tmpl_include 
name="index_new_layout_type.tpl"></tmpl_if> 

 
3. Create the file index_new_layout_type.tpl and use some of the other 

index layouts as a guide. Remember to create the file in both the 
Spanish and English directories. 

7.6 Users and groups management 

Password files in /simplicity/webauth are used to manage access to the 
administration page and embargo news for users and groups. Refer to the 
Apache documentation for information on how to update these files. 
 

http://httpd.apache.org/docs/2.2/programs/htpasswd.html 
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8 Additional Perl scripts 

8.1 Old Archives 

The old Perl scripts for the archives essentially do the same job as the new. 
However, first of all they do not use Perl modules, hence common functionality 
is implemented in separate Perl scripts, which are then executed from within 
other Perl scripts. Furthermore many scripts contain redundant information 
that hence require small changes to be propagated through many files. 
 
The dynamic indices are generated by scripts like /bin/images.pl and the static 
pages is also generated with scripts like staticimages.pl. The old static scripts 
though, are located in /scripts/staticscripts. Likewise there are multiple scripts 
like the up2datecheck.pl script in /scripts that checks if some page need to be 
regenerated. Data from the up-to-date check scripts are located in 
/scripts/data. Common scripts that are called from different other scripts are 
mostly located in /bin. 

8.2 Automatic front-page generation (frontpage.pl) 

A static front page (/index.html) is generated every 5 minutes. This is done 
instead of serving a dynamic on-the-fly calculated front page for all visitors, 
and saves CPU time for the web server (the content of the page rarely 
changes). The script rotates Flash and image advertisements on a daily basis, 
and places the latest three news items on the front-page. A new front-page can 
be generated manually by typing “cd /home/web/spacetelescope/docs; 
bin/frontpage.pl > index.html”. 

 
The front-page scripts rotate Flash from the directory /flash/dynamic. Images 
are rotated from /design/dynamic_images. In Flash links are made directly in 
the Flash-file, but images require a file placed in /design/dynamic_images 
called <image name>.link. So, to have an image named venus_transit.jpg, the 
link file would be named venus_transit.link. The content of the link file should 
just be a normal text file with one line, containing an absolute link to the 
website (e.g. /bin/videos.pl). 
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8.3 Editing Perl scripts on Windows 

To edit the Perl scripts under Windows, note the type of line breaks used. For 
instance in Notepad, the file is saved using a Windows line break, but before 
the Perl script can be executed on the server, these line breaks have to be 
converted to UNIX line breaks.  
 
Use the following command to convert all Windows line breaks to UNIX in a 
Perl script:  
dos2unix script.pl script.pl 

 
And make the file executable with the command: 
chmod 755 script.pl 

8.4 Source code for Perl scripts 

For security reasons the Perl scripts are not listed here. Contact Lars Lindberg 
Christensen by sending an email to lars@eso.org to obtain the source code for 
the Perl scripts.  
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9 .esoacc files 
.esoacc files are used to redirect requests, deny access to CSV files, deny 
directory listings, request authorization for embargo pages and change the 
default “File Not Found”-page.  
 
This is specific to ESO systems. Normally they are called .htaccess files. 

9.1 Redirects 

There are many redirects in the .esoacc-files on Spacetelescope.org. Most of 
them are single pages from the old web site that are mapped to the right pages 
in the new site. 
 
To make the site more friendly to search engines, there are some redirects to 
trick the search engines to believe that they are indexing normal pages, when 
they are actually indexing perl scripts (most robots will not index perl scripts). 
These redirects are typically of the form: 
 
/news/archive/<searchtype>/<string>/<viewtype>/<from>  

maps to 
/bin/news.pl?searchtype=<searchtype>&string=<string>&viewtype=<viewtype>&fro
m=<from>. 

 
For instance a request to /news/archive/year/2004// would show the list of 
news from 2004. 

9.1.1 Making a redirect 

To redirect requests to http://www.spacetelescope.org/goodies/old.html to 
http://www.spacetelescope.org/goodies/new.html: 
 
  Create an .esoacc-file in /goodies (if it’s not already there). The following 

two lines will do this 
 

RewriteEngine On #(this line should only be one time in a file) 
RewriteRule ^old/.html new.html [R] 

 
The RewriteEngine On turns on the module in Apache that makes the redirects. 
Make the actual redirect in the next line. The first part, ^old/.html, indicates 
that requests made to http://spacetelescope.org/goodies/old.html should be 
redirected. If the ^ in the front is omitted, the line will match the old.html 
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pages in the current directory and in any subdirectories. The last part new.html 
[R] tells Apache to redirect to new.html. If [R] is omitted, then the URL-
address in the browser will not be changed to 
http://www.spacetelescope.org/goodies/new.html. This is similar to renaming 
new.html to old.html and moving it to /goodies if it’s not already located 
there. 

9.2  “File Not Found”-page and “Authorization Required”-page 

If the web server can’t find a file request by a client, the page /error_404.html 
is shown. Likewise if a client fails to authenticate itself when requesting an 
embargo page, the page /error_401.html is shown. 

9.3 Password protection 

  Create directory $HOME/.webauth and set access rights:  
 
mkdir $HOME/.webauth; chmod o+x $HOME/.webauth; chmod o-r $HOME/.webauth. 

 
  Create a file .esoacc/.htaccess in the directory that is to be protected with 

basic authentication and add something to .esoacc/.htaccess. like  
 

AuthName "string describing the protected Web area" 
AuthType Basic 
 
AuthUserFile /path/to/my/homedirectory/.webauth/passwordfile 
 
require valid-user 

 
To give password access to selected users only in AuthUserFile use: 
  

require user username1 [username2 username3...]  

 
 Make sure that the file is readable by others (chmod o+r .esoacc) and 
always give the full path to the passwordfile in the parameter 
AuthUserFile. 

 
  Create the passwordfile (parameter AuthUserFile) in .webauth that will 

contain name:password records for the protected Web area, using the 
htpasswd command (often found in /usr/server/bin/): 
 

o htpasswd -c "AuthUserFile" pippo1  

Warning: Never use your Unix login password. 
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o add pippo1 to the .esoacc file 
o chmod o+r "AuthUserFile" 

 
To add more users just type: 
  htpasswd "AuthUserFile" pippo2 
  Add pippo2 to the .esoacc file  

9.4 Example of an advanced .esoacc file with redirects and password 
protection 

RewriteEngine on 

 
# The condition (first two lines) must be true for making  
# the rewrite. %1 in the RewriteRule references the text in 
# parentheses in the first or second line. 
RewriteCond %{QUERY_STRING} ^string=(heic[0-9]+)$ [OR] 
RewriteCond %{QUERY_STRING} ^&string=(heic[0-9]+)$ 
RewriteRule ^news/.pl /news/html/%1.html? [R] 

 
# The condition (first two lines) must be true for making  
# the rewrite. %1 in the RewriteRule references the text in 
# parentheses in the first or second line. 
RewriteCond %{QUERY_STRING} ^string=(heic[0-9]+)$ [OR] 
RewriteCond %{QUERY_STRING} ^&string=(heic[0-9]+)$ 
RewriteRule ^embargo/.pl /news/html/%1.html? [R] 

 
<Files embargo.pl> # Password protect the file embargo.pl 
AuthType Basic 
AuthName "Spacetelescope Embargo Page" 
  
AuthUserFile /path/to/passwordfile  
require user username 
</Files> 

 
ErrorDocument 401 /error_401.html # “Authorization required”-error page 
ErrorDocument 404 /error_404.html # “File not found”-error page 
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10 Searching 
To make the html-pages searchable, a utility called Htdig indexes the web 
pages every Monday, Wednesday and Friday at 1:01 AM. To run Htdig manually 
type “/home/web/bin/rundig.hubble” 
 
The configuration file for Htdig is located at 
/home/web/spacetelescope/docs/search/htdig/htdig-hubble.conf. 
 
HTML templates for the output from Htdig are located in following files (edited 
with Dreamweaver): 

- search/htdig/templates/wrapper.hubble.html (default layout) 
- search/htdig/templates/nomatch.hubble.html (is shown when no 

match is found) 
- search/htdig/templates/short.html (short description of found item) 
- search/htdig/templates/long.html (long description of found item) 

 
The /Videos and /Images archives are not indexed. 
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11 Link checker 
To check for broken links, link checking of all web pages (internal as well as 
external) is done on the 3rd of each month at 1:01 AM. The crontab entry (see 
next section) to run it looks like this: 
 
00 07 3 * * /home/web/spacetelescope/webcheck-1.0/webcheck.sh -o 
/home/web/spacetelescope/docs/search/webcheck/ http://www.spacetelescope.org 
2>/dev/null 
 
 

The result is located at http://www.spacetelescope.org/search/webcheck/. 
 

 
 
The version of Webcheck running on www.spacetelescope.org is a modified 
version that limits the number of false positives by not counting certain HTTP 
Result Codes as bad links. 
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12 Crontab 
To add a new cron job, edit /simplicity/installation/crontabfile, and type 
“crontab /path/to/crontabfile” to activate it. Below is an example of a crontab 
file. Note than there should be no line break between lines that are not 
separated with at least one blank line. 
 
01 01 * * 1,3,5 /home/web/bin/rundig.hubble 1>/dev/null 2>/dev/null 
 
00,05,10,15,20,25,30,35,40,45,50,55 * * * * cd 
/home/web/spacetelescope/docs/; bin/frontpage.pl > index.html 
 
00,05,10,15,20,25,30,35,40,45,50,55 * * * * /home/web/bin/perl 
/home/web/spacetelescope/docs/scripts/gennews.pl 1>/dev/null 

12.1 Editing the crontabfile 

Use a text editor to open /scripts/templates/crontabfile. Insert the following 
line: 
 
* * * * * command 1>/dev/null 2>/dev/null  

 
The asterisks (*) specify when to run the command, and denotes, from left: 
minutes, hours, day of month, month and day of week (0 is Sunday, 6 is 
Saturday). Each of them can be replaced by a list of times and ranges of time. 
For instance to run a command every 10th minute in the time range 8:00-10:00 
and 18:00-20:00, Monday to Friday, every month, use the following line: 
 
00,10,20,30,40,50 08-10,18-20 * * 1-5 command 1>/dev/null 2>/dev/null 

 
The last part “1>/dev/null 2>/dev/null” says that normal output “1” should be 
thrown away, likewise with any errors “2”. If the errors are to be kept then 
omit the “2>/dev/null” part.  
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